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1.  About these instructions for use
These instructions for use guide the user in utilizing the AltoStar® HBV PCR Kit 1.5 
on the AltoStar® Automation System AM16 (Hamilton; in the following summarized 
as AltoStar® AM16) with the AltoStar® Connect software (Version 1.7.4 or higher, 
Hamilton) for automated PCR setup and on the CFX96™ Deep Well Dx System 
(Bio-Rad, in the following summarized as CFX96™ DW Dx) with the CFX Manager™ 
Dx software (Version 3.1, Bio-Rad) for real-time PCR. For details on the use of the 
AltoStar® AM16, the AltoStar® Connect software, the AltoStar® Purification Kit 1.5, 
the AltoStar® Internal Control 1.5 and the CFX96™ DW Dx, refer to the respective 
instructions for use listed below: 

•	 AltoStar® Automation System AM16 Operator's Manual IVD (Hamilton) 

•	 AltoStar® Connect Software Manual IVD (Hamilton) 

•	 Instructions for use AltoStar® Purification Kit 1.5 

•	 Instructions for use AltoStar® Internal Control 1.5 

•	 CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual 
(Bio-Rad)

Throughout this manual, the terms CAUTION and NOTE have the following 
meanings:

CAUTION

Highlights operating instructions or procedures which, if not followed 
correctly, may result in personal injury or impact product performance. 
Contact altona Diagnostics technical support for assistance.

NOTE

Information is given to the user that is useful but not essential to the task 
at hand. 

Read the instructions for use carefully before using the product.
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2.  Intended use
The AltoStar® HBV PCR Kit 1.5 is an in vitro diagnostic test, based on real-time 
PCR technology, for the detection and quantification of hepatitis B virus (HBV) 
specific DNA (genotypes A to H) in human EDTA plasma. It is configured for use 
with the CFX96™ Deep Well Dx System (Bio-Rad) in combination with the AltoStar® 
Automation System AM16, the AltoStar® Purification Kit 1.5 and the AltoStar® 
Internal Control 1.5.

The AltoStar® HBV PCR Kit 1.5 is intended to be used for viral load monitoring in 
individuals with HBV infection.

The results generated with the AltoStar® HBV PCR Kit 1.5 have to be interpreted in 
conjunction with other clinical and laboratory findings. 

The AltoStar® HBV PCR Kit 1.5 is intended for use by professional users trained in 
molecular biological techniques and in vitro diagnostic procedures.
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3.  Kit content
The AltoStar® HBV PCR Kit 1.5 contains the following components:

Table   1: Kit components

Lid color Component Number of tubes Nominal volume 
[μl/tube]

Blue Master A1) 8 2402)

Purple Master B1) 8 3003)

Red QS14) 2 550
Red QS24) 2 550
Red QS34) 2 550
Red QS44) 2 550
White NTC5) 2 550

1)	Contains biological material of animal origin
2)	Contains an additional volume of 40 µl to compensate the dead volume of the AltoStar® 

AM16's liquid handling
3)	Contains an additional volume of 52 µl to compensate the dead volume of the AltoStar® 

AM16's liquid handling
4)	Quantification Standard (Positive Control)
5)	No Template Control (Negative Control)

CAUTION

Before first use check the product and its components for completeness 
with respect to number, type and filling. Do not use a defective or 
incomplete product, product performance could be compromised.

The AltoStar® HBV PCR Kit 1.5 contains enough reagents to perform 96 reactions 
in a maximum number of 8 runs.
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The product is shipped on dry ice. Upon receipt and before first use, check the 
product and its components for:

•	 Integrity 

•	 Completeness with respect to number, type and filling 

•	 Correct labeling 

•	 Expiration date

•	 Frozen state 

•	 Clarity and absence of particles

If one or more product components are not frozen upon receipt, if tubes have been 
compromised during shipment or are missing, contact altona Diagnostics technical 
support for assistance (see chapter 11. Technical support).

4.  Storage and handling
All reagents included in the AltoStar® HBV PCR Kit 1.5 are ready-to-use solutions.

4.1  Storage
All components of the AltoStar® HBV PCR Kit 1.5 must be stored at -25 °C to -15 °C 
upon arrival.

CAUTION

Improper storage conditions could compromise product performance.

CAUTION

Do not use products beyond the expiration date. The use of expired 
products could compromise product performance. 
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4.2  Handling

CAUTION

Do not exceed thaw-freeze-sequence and handling durations specified 
in these instructions for use, as this could compromise product 
performance.

CAUTION

Improper handling of product components and samples may cause 
contamination and could compromise product performance:
	- Do not interchange vial or bottle caps. 
	- Store positive and/or potentially positive material separated from the 

kit components.
	- Use separated working areas for sample preparation/reaction setup 
and amplification/detection activities. 

	- Always dispose gloves after handling positive and/or potentially 
positive material. 

	- Do not open the PCR plates post amplification.

CAUTION

Do not mix components from different kit lots. The use of different kit lots 
could compromise product performance.

4.2.1  Master A and Master B
After thawing, Master A and Master B are stable for 5 hours at up to +30 °C.

NOTE

If Master A and Master B were thawed but not used, they can be refrozen 
and thawed again once for later runs. If opened, discard the lids and use 
new lids to avoid contamination of the reagents.
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4.2.2  Quantification Standards and No Template Control
1.	 After thawing, the Quantification Standards (QSs) and the No Template Control 

(NTC) are stable for 5 hours at up to +30 °C. 

2.	 Discard the lids of the QSs and NTC tubes at each use and use new lids to 
avoid contamination of the reagents. 

3.	 After use close the QSs and NTC tubes with new lids and freeze them 
immediately. 

4.	 Do not exceed the following thaw-freeze-sequence for each QS and NTC tube: 
Thaw 1 → Freeze 1 → Thaw 2 → Freeze 2 → Thaw 3 → Freeze 3 → Thaw 4

5.  Product description
The AltoStar® HBV PCR Kit 1.5 is an in vitro diagnostic test for the detection and 
quantification of HBV specific DNA in human EDTA plasma. 

It is based on real-time PCR technology, utilizing polymerase chain reaction (PCR) 
for the amplification of HBV specific target sequences and fluorescently labeled 
target specific probes for the detection of the amplified DNA.

In addition to the HBV DNA specific amplification and detection system the assay 
includes oligonucleotides for the amplification and detection of the internal control 
(in the following abbreviated as IC; AltoStar® Internal Control 1.5).

Probes specific for HBV DNA are labeled with the fluorophore FAM™. The probe 
specific for the IC is labeled with a fluorophore (JOE™) detectable in the VIC™ 
channel.

Using probes linked to distinguishable dyes enables the parallel detection of HBV 
specific DNA and the IC in corresponding detection channels of the CFX96™ 
DW Dx.
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5.1  Background
The hepatitis B virus (HBV) causes the disease hepatitis B. The hepatitis B virus is 
unique among human viral pathogens as it is a DNA virus that replicates via an RNA 
intermediate, and thus belongs to the reverse transcribing DNA and RNA viruses. 
HBV is part of the Hepadnaviridae family of viruses, which consists of genotype 
A–H [1,2].

The genomic structure of HBV is both compact and complex, with the ability to 
encode 7 distinct proteins with only 3.2 kb. These proteins are the polymerase 
protein (Pol gene); core antigen (HBsAG) and e antigen (HBeAG); large, medium, 
and small surface-antigen proteins (S gene); and the X protein (X gene) [2].

HBV is transmitted via blood or other body fluids and can survive outside the body 
for at least 7 days. The most common transmission types are perinatal mother-to-
infant transmission or horizontal transmission between children up to the age of 
5 years.

Sources of infection are also medical surgery instruments, tattooing needles or 
razors that are contaminated with blood [3].

The virus may be evidenced 30–60 days after infection, and can persist in the body. 
The infected person can develop chronic hepatitis B. Symptoms can reach from 
yellowing of skin and eyes (jaundice) and dark urine to extreme fatigue, nausea, 
vomiting and abdominal pain, which can last for several weeks, but carriers can 
be asymptomatic as well. The worst-case scenario is the development of an acute 
or chronic hepatitis, with progression to liver cirrhosis or hepatocellular carcinoma 
(HCC) [3].

Hepatitis B cannot be cured, so far. However, medication for symptom treatment is 
available, and slowdown of cirrhosis progression is possible. Despite vaccinations, 
hepatitis B virus infections are still very common worldwide. Hepatitis B remains 
a global health problem with about 240 million people suffering from chronic HBV 
infection and with 887,000 HBV-related deaths per year (numbers increasing again 
since 2015) [3].
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Hepatitis B virus prevalence is highest in the Western Pacific and Africa where 
6.2 % and 6.1 % respectively of the adult population is infected. Infections occur 
also in the WHO-specified regions, such as the Eastern Mediterranean, South-East 
Asia, Europe and the Americas [3].

Therefore, there is a high demand for viral hepatitis B testing as important part of all 
prevention and treatment efforts. For mass screenings, rapid and accurate detection 
of HBV is of pivotal importance. Real-time PCR HBV kits with high sensitivity meet 
these objectives.

5.2  Component description

5.2.1  Master A and Master B
Master A and Master B contain all components (PCR buffer, DNA polymerase, 
magnesium salt, primers and probes) to allow  the PCR mediated amplification and 
target detection of HBV specific DNA and of the IC in one reaction setup.

5.2.2  Quantification Standards
The QSs contain standardized concentrations of HBV specific DNA (see table 2). 
They were calibrated against the 4th WHO International Standard for HBV DNA 
for Nucleic Acid Amplification Techniques (NIBSC code: 10/266, genotype A2). 
The QSs are used to verify the functionality of the HBV DNA specific amplification 
and detection system as well as to generate a standard curve, which allows the 
quantification of HBV specific DNA in a sample.

Table   2: Quantification Standards

Quantification Standard Concentration [IU/µl]

QS1 1.00E+04

QS2 1.00E+03

QS3 1.00E+02

QS4 1.00E+01
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5.2.3  No Template Control
The NTC contains no HBV specific DNA but does contain the IC template. The NTC 
is used as negative control for the HBV DNA specific real-time PCR and indicates 
possible contamination of Master A and Master B.

5.3  AltoStar® Workflow
The AltoStar® Workflow comprises the following IVD products:

•	 AltoStar® Automation System AM16 (Hamilton)

•	 AltoStar® Connect software version 1.7.4 or higher (Hamilton)

•	 CFX96™ Deep Well Dx System (Bio-Rad) with CFX Manager™ Dx software 
version 3.1 (Bio-Rad)

The workflow includes the following steps:

1.	 Programming an AltoStar® run. 

2.	 Purification run on the AltoStar® AM16 using the AltoStar® Purification Kit 1.5 
and the AltoStar® Internal Control 1.5. 

3.	 PCR setup run on the AltoStar® AM16 using the AltoStar® HBV PCR Kit 1.5. 

4.	 Real-time PCR run on a CFX96™ DW Dx.

For further details on steps 3 and 4 of the workflow, refer to chapter 7. Using the 
AltoStar® HBV PCR Kit 1.5 with the AltoStar® Workflow. All sample types and sample 
volumes specified for use with the AltoStar® Purification Kit 1.5 can be processed 
simultaneously on the AltoStar® AM16. Each sample can be analyzed with as many 
real-time PCR assays in parallel as the available eluate allows.

NOTE

Assays with differing PCR temperature profiles are automatically sorted 
to separate PCR plates. 
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5.4  Samples

5.4.1  Sample types
The following sample type is validated for use with the AltoStar® HBV PCR Kit 1.5:

•	 Human EDTA plasma

CAUTION

Do not use other sample types! The use of other sample types could 
compromise product performance.

5.4.2  Sample collection and handling
Blood has to be collected with commercially available standard blood collection 
systems (e.g. Sarstedt, Becton Dickinson, Greiner or equivalent). Tube contents 
should be mixed directly after sample collection. The blood samples should be 
shipped cooled at +2 °C to +8 °C. Transport should occur following the local and 
national instructions for the transport of biological material.  

For generation of EDTA plasma, whole blood should be centrifuged according 
to the instructions provided by the manufacturer of the collection system within 
24 hours after collection. Before use EDTA plasma should not be stored for more 
than 48 hours at room temperature (+20 °C to +25 °C), 5 days at +2 °C to +8 °C or 
2 months at -25 °C to -15 °C.

CAUTION

Always treat samples as infectious and (bio-)hazardous material in 
accordance with safety and laboratory procedures. For sample material 
spills promptly use an appropriate disinfectant. Handle contaminated 
materials as biohazardous.
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NOTE

Frozen storage of samples does not compromise kit performance. 
When working with frozen samples, make sure samples are completely 
thawed and properly mixed before use.

6.  Warnings, precautions and limitations
•	 Before first use check the product and its components for completeness with 

respect to number, type and filling. Do not use a defective or incomplete 
product, product performance could be compromised.

•	 Improper storage conditions could compromise product performance.

•	 Do not use products beyond the expiration date. The use of expired products 
could compromise product performance. 

•	 Do not exceed thaw-freeze-sequence and handling durations specified in 
these instructions for use, as this could compromise product performance.

•	 Improper handling of product components and samples may cause 
contamination and could compromise product performance:

	◦ Do not interchange vial or bottle caps.

	◦ Store positive and/or potentially positive material separated from the kit 
components.

	◦ Use separated working areas for sample preparation/reaction setup and 
amplification/detection activities. 

	◦ Always dispose gloves after handling positive and/or potentially positive 
material. 

	◦ Do not open the PCR plates post amplification.

•	 Do not mix components from different kit lots. The use of different kit lots could 
compromise product performance.

•	 Do not use other sample types! The use of other sample types could 
compromise product performance. 

•	 Always treat samples as infectious and (bio-)hazardous material in accordance 
with safety and laboratory procedures. For sample material spills promptly use 
an appropriate disinfectant. Handle contaminated materials as biohazardous.
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•	 Storage of eluates under wrong conditions may lead to degradation of the 
HBV target sequence and could compromise product performance.

•	 Do not use an assay protocol version other than the one indicated on the 
2D barcode in these instructions for use. Using an incorrect assay protocol 
version could compromise product performance.

•	 A lack of centrifugation of the product components after thawing may cause 
contamination with reagent residues in the lids and could compromise product 
performance.

•	 Do not reuse tube caps to avoid contamination of the reagents, as this could 
compromise product performance.

•	 As with any diagnostic test, results shall be interpreted in consideration of all 
clinical and laboratory findings.

•	 The presence of PCR inhibitors (e.g. heparin) could cause false negative or 
invalid results.

•	 Do not exceed the PCR mix storage time, as this could compromise product 
performance.

•	 In case the sample contains other pathogens than HBV, competition with the 
target amplification or cross-reactivities may occur, causing incorrect IVD 
examination results.

•	 Disposal of hazardous and biological waste shall comply with local and 
national regulations to avoid environmental contamination.

•	 Potential mutations within the target regions of the HBV genome covered by 
primers and/or probes used in the kit may result in underquantification and/or 
failure to detect the presence of the pathogen.
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7.  Using the AltoStar® HBV PCR Kit 1.5 with the AltoStar® 
Workflow

The following part of these instructions for use describes the use of the AltoStar® 
HBV PCR Kit 1.5 in conjunction with the AltoStar® Workflow. The AltoStar® Workflow 
comprises different IVD products (AltoStar® AM16, the AltoStar® Connect software, 
the AltoStar® Purification Kit 1.5, the AltoStar® Internal Control 1.5 and the CFX96™ 
DW Dx). Use of those products is described in detail in the respective instructions 
for use.

•	 AltoStar® Automation System AM16 Operator's Manual IVD (Hamilton)

•	 AltoStar® Connect Software Manual IVD (Hamilton)

•	 Instructions for use AltoStar® Purification Kit 1.5

•	 Instructions for use AltoStar® Internal Control 1.5

•	 CFX96™ Dx and CFX96™ Deep Well Dx Systems Operation Manual 
(Bio-Rad)

7.1  Sample volume
The AltoStar® HBV PCR Kit 1.5 is validated for nucleic acid purifications from a 
sample volume of 1,000 μl using the AltoStar® AM16. Additional sample volume has 
to be provided to account for the dead volume of the sample tube used (see chapter 
7.2 Sample tubes).

NOTE

Up to 48 samples of 1,000 µl can be processed simultaneously in one 
purification run. 

7.2  Sample tubes
Sample tubes suitable for use on the AltoStar® AM16 can be purchased from altona 
Diagnostics (7 ml tube with cap, 82 x 13 mm, VK000010). Other sample tubes can 
be tested for applicability by the user. For details, refer to the instructions for use of 
the AltoStar® Purification Kit 1.5.
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7.3  Sample barcodes
For automated sample identification by the AltoStar® AM16 all sample tubes must 
be labeled with a suitable barcode. For details, refer to the instructions for use of the 
AltoStar® Purification Kit 1.5.

7.4  Material and devices required but not provided 
The material and devices shown in table 3 must be ordered from altona Diagnostics.

Table   3: Required material and devices

Material Description Order No.

AltoStar® Molecular Diagnostic 
Workflow

Product bundle containing the AltoStar® 
Automation System AM16, the AltoStar® 
Connect software (Version 1.7.4 or higher) 
and IT hardware

AM16

AltoStar® Detection

Product bundle containing the CFX96™ 
Deep Well Dx System with CFX 
Manager™ Dx Software (Version 3.1), a 
barcode scanner and IT hardware

DT16

AltoStar® Purification Kit 1.5
Nucleic acid isolation and purification 
chemistry for use with the AltoStar® 
Automation System AM16

PK15-16/ 
PK15-46

AltoStar® Internal Control 1.5
Nucleic acid extraction and PCR 
amplification and detection control

IC15-16/ 
IC15-46

PCR Plate
Semi-skirted, barcoded 96 multi-well plate 
with white wells

VK000005

PCR Plate Sealing Foil Sealing foil for the PCR plate VK000006

1,000 μl CO-RE Tips
1,000 µl filter tips for use with the 
AltoStar® Automation System AM16 

VK000007

300 μl CO-RE Tips
300 μl filter tips for use with the AltoStar® 
Automation System AM16

VK000008

Pooling Tube
Barcoded tube for pooling of PCR 
reagents

VK000002
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Material Description Order No.

Waste Bag
Autoclavable sterile bag for use with the 
AltoStar® Automation System AM16

VK000009

Screw Cap - red Screw cap for QS1–QS4 tubes VK000012

Screw Cap - blue Screw cap for Master A tubes VK000013

Screw Cap - purple Screw cap for Master B tubes VK000015

Screw Cap - white Screw cap for NTC tubes VK000016

Table   4: Additional laboratory material and devices 

Material Description Order No.

Plate Sealer
e.g. AltoStar® Plate Sealer VK000023

e.g. PX1 Plate Sealer (Bio-Rad) VK000033

7.5  General material and devices
•	 Vortex mixer

•	 Powder-free gloves (disposable)

•	 Centrifuge for centrifugation of the AltoStar® HBV PCR Kit 1.5 components

•	 Centrifuge for centrifugation of PCR plates
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7.6  Procedure

7.6.1  Overview of the AltoStar® Workflow
The steps of the complete AltoStar® Workflow are summarized in table 5. Information 
on specific settings for use with the AltoStar® HBV PCR Kit 1.5 are provided in 
chapter 7.6.2 Programming an AltoStar® run. For detailed instructions for steps 1–5, 
refer to the instructions for use of the AltoStar® Purification Kit 1.5, the AltoStar® 
Connect software and the AltoStar® AM16.

Steps 6–11 are described in more detail in chapters 7.6.3 Starting a PCR setup run 
to 7.6.10 Export of PCR results for manual result interpretation.

Table   5: Overview of the AltoStar® Workflow

Step Action

1. Start the AltoStar® AM16 •	 Switch on the AltoStar® AM16.
•	 Switch on the computer and the monitor.
•	 Start the AltoStar® Connect software.

2. Perform maintenance •	 In the menu bar click Application → Instrument 
Maintenance. 

	◦ If weekly maintenance is due, click Start Weekly 
Maintenance.

	◦ If daily maintenance is due, click Start Daily 
Maintenance.

•	 Follow the on-screen instructions for the maintenance 
process.

3. Program an AltoStar® 
run

•	 In the menu bar click Program Run → Program Run 
(AltoStar® Purification). Alternatively, go back to the 
Start screen and click the Program Run button.

•	 Enter samples or import from the LIMS.
•	 Select the following assay for the samples unless 

already imported from the LIMS:

	◦ AltoStar® HBV PCR Kit 1.5 

•	 Click the Create Run button in the tool bar to create 
the AltoStar® run.
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Step Action

4. Start a purification run •	 In the menu bar click Purification → Start 
Purification. Alternatively, go back to the Start screen 
and click the Start Purification button.

•	 Select the purification run to be started to display the 
samples included in the selected purification run.

•	 Prepare the purification reagents:

	◦ Ensure that the purification reagents to be used 
have the same loading number (except AltoStar® 
Internal Control 1.5) and are not expired.

	◦ If precipitates are visible in the Lysis Buffer, heat it 
(≤ +50 °C) until completely dissolved.

	◦ Thaw the IC (AltoStar® Internal Control 1.5) and 
vortex for 5 seconds.

	◦ Vortex the Magnetic Beads for 5 seconds without 
wetting the lid.

•	 Prepare the samples for the purification run to be 
started as described in the instructions for use of the 
AltoStar® Purification Kit 1.5.

•	 Click the Start Run button in the tool bar.
•	 Follow the loading dialogs and load the instrument 

accordingly.
•	 Confirm the Loading complete message with OK or 

wait 10 seconds.

The system will now perform the purification run 
automatically.

5. Finish the purification 
run

•	 Make sure the loading tray is empty and confirm the 
Run finished dialog with OK.

•	 Follow the instructions in the Maintenance dialog and 
confirm with OK.

•	 Seal and store the components of the AltoStar® 
Purification Kit 1.5 that can be reused.

The eluates in the unsealed eluate plate are stable at room 
temperature (max. +30 °C) for a total of 4 hours.

•	 If the associated PCR setup run is not started right 
away, seal the eluate plate with an Eluate Plate Sealing 
Foil and store at +2 °C to +8 °C for up to 24 hours.

•	 View the purification run results to confirm successful 
processing of each sample.
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Step Action

6. Start a PCR setup run •	 In the menu bar, click PCR Setup → Start PCR Setup. 
Alternatively, go back to the Start screen and click the 
Start PCR Setup button. 

•	 Select the PCR setup run to be started in order to 
display the eluate plate and reagents included in the 
selected PCR setup run.

•	 Prepare the PCR reagents:

	◦ Ensure that masters and controls to be used are 
from the same kit lot and are not expired.

	◦ Thaw the required amount of master and control 
tubes, vortex briefly and spin down in a centrifuge.

•	 If the eluate plate is sealed, briefly centrifuge the plate 
and unseal carefully.

•	 Click the Start Run button in the tool bar.
•	 Follow the Loading dialog and load the instrument 

accordingly.
•	 Confirm the Loading complete message with OK or 

wait 10 seconds.

The system will now perform the PCR setup run 
automatically. 

7. Finish the PCR setup 
run

•	 Make sure the loading tray is empty and confirm the 
Run finished dialog with OK.

•	 Follow the instructions in the Maintenance dialog and 
confirm with OK.

•	 Close and store the components of the AltoStar® HBV 
PCR Kit 1.5 that can be reused.

•	 View the PCR setup run results to confirm successful 
processing of each sample.

8. Seal the PCR plate •	 Seal the PCR plate with a PCR Plate Sealing Foil.
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Step Action

9. Start the PCR run •	 Switch on the CFX96™ DW Dx, the attached computer 
and the monitor.

•	 Start the CFX Manager™ Dx software.
•	 Open the CFX96™ DW Dx.
•	 Centrifuge the PCR plate and insert it into the CFX96™ 

DW Dx.
•	 Select File → Open → LIMS File… from the menu 

bar.
•	 Scan the barcode of the PCR plate with the handheld 

barcode scanner.
•	 Close the CFX96™ DW Dx.
•	 Click the Start Run button to start the PCR run. Name 

and save the PCR run file.

The CFX96™ DW Dx will now perform the PCR run 
automatically.

10. Separate assays for 
individual analysis

•	 Separate all assays in the PCR run into distinct well 
groups.

11. Analyze the data and 
interpret the PCR run 
results

For each well group individually:

•	 Perform baseline correction in all wells for all detection 
channels used.

•	 Exclude wells with irregular PCR signals.
•	 Set the thresholds of all detection channels according 

to the controls.
•	 Exclude wells containing invalid data.
•	 Generate the LIMS result file for export of results to 

the LIMS.
•	 Generate the result report for manual result 

interpretation.

CAUTION

Storage of eluates under wrong conditions may lead to degradation of 
the HBV target sequence and could compromise product performance.
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7.6.2  Programming an AltoStar® run
For detailed information on starting an AltoStar® run, refer to the instructions for use 
of the AltoStar® Purification Kit 1.5, the AltoStar® Connect software and the AltoStar® 
AM16. Specific settings for use with the AltoStar® HBV PCR Kit 1.5 are listed below:

•	 For quantitative assay application QS1–4 and NTC are selected and for 
qualitative assay application QS4 and NTC are selected.

•	 The required sample volume is 1,000 μl plus the dead volume for the respective 
sample tube (see chapters 7.1 Sample volume and 7.2 Sample tubes).

•	 The required eluate volume for the AltoStar® HBV PCR Kit 1.5 is 45 μl.

•	 Make sure that the correct assay protocol version is used for the run. For 
information on the current protocol version see chapter 15. Assay protocol 
for the AltoStar® Connect software and information for LIMS integration. The 
respective assay protocol is encoded in the 2D barcode displayed there. 
For information on purification and assay protocol import into the AltoStar® 
Connect software, refer to the respective instructions for use.

CAUTION

Do not use an assay protocol version other than the one indicated on 
the 2D barcode in these instructions for use. Using an incorrect assay 
protocol version could compromise product performance.

7.6.3  Starting a PCR setup run
1.	 Select PCR Setup → Start PCR Setup in the menu bar. Alternatively, go back 

to the Start screen of the AltoStar® Connect software and select the Start PCR 
Setup button. The Start PCR Setup Run screen is displayed.

The pending PCR setup runs are displayed in the Programmed PCR Setup Runs 
table on the left side of the screen.
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2.	 Select the PCR setup run to be started in the Programmed PCR Setup Runs 
table. 

•	 The samples included in the selected PCR setup run are displayed in the 
table on the top right side of the screen (Samples in selected PCR Setup 
Run). 

•	 The QSs and controls required for the selected PCR setup run are displayed 
in the table on the middle right side of the screen (Controls in selected PCR 
Setup Run).

•	 The number of master tubes required for the selected PCR setup run is 
displayed in the table on the bottom right side of the screen (Required 
master tubes for the selected PCR Setup Run).

NOTE

The number of prioritized samples in a PCR setup run is displayed in 
the column No. of prioritized Samples. Conduct PCR setup runs with 
prioritized samples first to facilitate fastest processing of prioritized 
samples.

Before clicking the Start Run button in the tool bar, prepare the required reagents 
as described in chapter 7.6.3.1 Preparing reagents for a PCR setup run. If the eluate 
plate required for the selected PCR setup run has been sealed for storage prepare it 
as described in the instructions for use of the AltoStar® Purification Kit 1.5. 

7.6.3.1  Preparing reagents for a PCR setup run
1.	 Thaw the required QSs, controls and the required number of master tubes 

completely at room temperature (max. +30 °C). 

2.	 Mix the reagents by gentle vortexing. 

3.	 Centrifuge the tubes briefly to remove drops from the lid.

CAUTION

A lack of centrifugation of the product components after thawing 
may cause contamination with reagent residues in the lids and could 
compromise product performance.
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7.6.3.2  Loading the AltoStar® AM16 for a PCR setup run
For detailed information regarding the loading process, refer to the instructions for 
use of the AltoStar® Automation System AM16 and the AltoStar® Connect software.

1.	 Click the Start Run button in the tool bar of the Start PCR Setup Run screen 
to display the Loading dialog.

The Loading dialog consists of a visual representation of the AltoStar® AM16 
deck at the top and a table specifying the carriers, the respective tracks on the 
AltoStar® AM16 deck for each carrier, the material to be loaded onto each carrier 
and comments with respect to the carrier loading.

NOTE

To visualize the position of an item on a carrier and the position of the 
carrier on the AltoStar® AM16 deck, select the respective row of the table 
in the Loading dialog.

The position of the item and its carrier is visualized:

	- Highlighted in red in the visual representation of the instrument deck
	- On the AltoStar® AM16 by flashing loading lights above the tracks 

where the selected carrier must be placed

2.	 Load the required material, the prepared eluate plate and the prepared 
reagents onto the suitable carriers.

•	 Exchange only completely empty 1,000 μl tip racks for completely full 
1,000 μl tip racks on the tip carrier.

•	 Exchange only completely empty 300  μl tip racks for completely full 
300 μl tip racks on the tip and plate carrier.

NOTE

Exchange of tip racks, which are not completely empty as well as 
handling of individual tips may interfere with the automatic tip 
management and cause run aborts.

•	 Place the required eluate plate with well A1 to the left of the black plate 
position.



29

AltoStar® HBV PCR Kit 1.5

•	 Place a PCR plate with well A1 to the left of the silver front plate position.

•	 Load a tube carrier 24 with one unused pooling tube for each assay in the 
PCR setup run.

•	 Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

•	 Load the reagent tube carrier 32 with the assay components required for 
the PCR setup run.

•	 Gently push the tubes all the way to the bottom of the carrier and rotate the 
tubes until the tube barcodes are visible through the carrier window.

NOTE

The position of the individual tubes on the carriers is arbitrary.

NOTE

The volume of the loaded components is not checked by the system prior 
to processing. Insufficient component volume will prevent successful 
PCR setup for the affected assay. 

NOTE

Starting a PCR setup run with lids still on the tubes may cause the run 
to abort during processing. 

3.	 Load the carriers with the carrier barcode towards the rear facing right.

4.	 Insert populated carriers into the respective tracks between the front and rear 
slide blocks of the loading tray until they touch the stop hooks on the far side 
of the loading tray.

NOTE

Pushing the carriers past the stop hooks may damage the instrument 
and interfere with the loading process.

5.	 Check that the tip eject sheet and the tip waste container are in the correct 
position and a new waste bag is placed in the container.
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6.	 Click OK in the Loading dialog to proceed with the loading process.

NOTE

By clicking Cancel the PCR setup run will be canceled, but it can be 
started again (see chapter 7.6.3 Starting a PCR setup run). 

The AltoStar® AM16 draws the carriers into the instrument and performs barcode 
verification.

NOTE

The AltoStar® AM16 automatically verifies:

	- Correct type and localization of the loaded carriers
	- Correct identity and position of the items loaded on the carriers
	- Lot congruence of the components of the individual AltoStar® assay 

kits
	- Non-expiry of all loaded AltoStar® assay components
	- Correct positioning of the tip eject sheet

If any of these checks fail, the user is prompted with a message dialog specifying 
the problem at hand and instructions to correct the issue accordingly. For further 
information regarding error handling, refer to the instructions for use of the AltoStar® 
Connect software.

NOTE

Altering positions of any loaded item after the carrier has been drawn 
into the instrument may result in the abort of the PCR setup run and/or 
damage to the instrument.

When all checks have passed the Loading complete dialog is displayed.

7.	 Confirm the Loading complete dialog by clicking OK or wait 10 seconds for the 
automatic start of the process.
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NOTE

By clicking Cancel the PCR setup run will be canceled, but it can be 
started again (see chapter 7.6.3 Starting a PCR setup run).

The PCR setup run is started and will be conducted without user intervention.

7.6.3.3  During the PCR setup run
No further user interaction is required until the PCR setup run has finished. The 
Processing Status screen is displayed showing the status of the PCR setup run and 
the estimated time remaining.

NOTE

Pushing or pulling carriers or the door of the AltoStar® AM16 during a 
PCR setup run may abort the run.

7.6.4  End of the PCR setup run
At the end of the PCR setup run the Run finished dialog is displayed.

1.	 Make sure that the loading tray is empty.

2.	 Confirm the Run finished dialog by clicking OK.

The AltoStar® AM16 will unload the carriers. Make sure not to stand in the way of 
the unloading carriers.

After unloading the Maintenance dialog is displayed.

3.	 Follow the instructions of the Maintenance dialog.

The table of the dialog displays the number of reactions in the master tubes that 
were not used in the PCR setup run.
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4.	 If another PCR setup run using the currently loaded eluate plate is to be started 
right away, the eluate plate can remain unsealed on the carrier position. If this 
is not the case, seal and store the eluate plate. For further information, refer to 
the instructions for use of the AltoStar® Purification Kit 1.5.

NOTE

The eluates in the eluate plate are stable at room temperature (max. 
+30 °C) for a total of 4 hours after completion of the purification run.

5.	 Close reagent tubes with suitable unused tube caps.

CAUTION

Do not reuse tube caps to avoid contamination of the reagents, as this 
could compromise product performance.

6.	 Store reagents for reuse as described in chapter 4.2 Handling. 

7.	 Dispose of the used materials (see chapter 9. Disposal). 

8.	 Confirm the Maintenance dialog by clicking OK.

7.6.4.1  PCR setup run results
The PCR setup run results are saved in the AltoStar® Connect software.

1.	 Click PCR Setup → PCR Setup Results in the menu bar to access the Results 
screen.

The Results screen displays a table with all samples used in the latest PCR setup 
run and a column Status at the right showing if the PCR setup process for a given 
sample was conducted completely (see table 6).
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Table   6: PCR setup run results

Status PCR setup run result

Processed
•	 The eluate was successfully processed in the PCR setup run.
•	 The resulting PCR mix is ready for use in a PCR run. 

Error
•	 The eluate was not processed successfully.
•	 The respective PCR mix will be automatically omitted in the 

following PCR analysis. 

2.	 To view the results of prior PCR setup runs, click the Load button in the menu 
bar, select the desired PCR setup run from the list in the opening Load Results 
dialog and click OK.

3 PCR setup run result files are automatically generated by the AltoStar® Connect 
software:

•	 A LIMS file (.xml) to pass detailed information about the PCR setup run 
including results back to the LIMS 

•	 A report (.pdf) containing detailed information about the PCR setup run 
including results for documentation purposes 

•	 A cycler file (.plrn) for automatic programming of the CFX96™ DW Dx

These files are saved to the location specified in the system settings of the AltoStar® 
Connect software.

NOTE

PCR setup run result files can be generated again by loading the 
respective PCR setup run and clicking the Create LIMS File button to 
generate the LIMS file, the Create Report button to generate the report 
or the Create Bio-Rad Cycler File button to generate the cycler file.
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7.6.5  Sealing of the PCR plate
After completion of the PCR setup run, the PCR plate must be sealed with a PCR 
Plate Sealing Foil. It is recommended to use the AltoStar® Plate Sealer [4s3™ Semi-
Automatic Sheet Heat Sealer (4titude)] or the PX1 PCR Plate Sealer (Bio-Rad). 
The suitability of plate sealers other than the recommended plate sealers has to be 
evaluated by the user.

If one of the recommended plate sealers is used for sealing, proceed as follows:

1.	 Switch on the plate sealer and make sure that the plate adapter is not in the 
drawer.

2.	 Ensure that the settings of the plate sealer are as follows:

Table   7: Settings of the plate sealer

Plate sealer Settings

Temperature [°C] Time [s]

AltoStar® Plate Sealer 
[4s3™ Semi-Automatic 
Sheet Heat Sealer (4titude)]

170 2

PX1 PCR Plate Sealer 
(Bio-Rad)

175 3

3.	 Wait until the set temperature is reached. This may take several minutes.

4.	 Place the PCR plate on the plate adapter of the plate sealer.

5.	 Place one PCR Plate Sealing Foil on the PCR plate so that the print ‘THIS 
SIDE UP’ is readable. Make sure that all wells of the PCR plate are covered 
with foil and no well is obscured by the writing.

NOTE

Operating the plate sealer without the plate adapter placed in the 
drawer may render the sealer nonfunctional. In this case, contact altona 
Diagnostics technical support for assistance (see chapter 11. Technical 
support).
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NOTE

If the PCR Plate Sealing Foil or the frame is placed incorrectly, the foil 
may stick to the heating plate within the plate sealer during sealing. This 
will render the sealer nonfunctional. In this case, or if the sealing step 
has been initiated without a PCR Plate Sealing Foil, let the plate sealer 
cool down to room temperature and contact altona Diagnostics technical 
support for assistance (see chapter 11. Technical support).

6.	 Assemble the sealing frame on top to hold down the sealing foil.

7.	 Open the drawer by pressing the Operate*/ ** button.

8.	 Place the assembly consisting of the plate adapter, the PCR plate, the PCR 
Plate Sealing Foil and the sealing frame into the plate sealer and press the 
Operate*/ ** button.

9.	 The drawer closes automatically, seals for the set time and reopens 
automatically.

10.	Take the sealed PCR plate and the plate adapter out of the plate sealer and 
close the plate sealer by pressing the Close*/ ** button.

*	 AltoStar® Plate Sealer [4s3™ Semi-Automatic Sheet Heat Sealer (4titude)]
**PX1 PCR Plate Sealer (Bio-Rad)

7.6.5.1  PCR mix stability
After completion of the PCR setup run the PCR mix in the sealed PCR plate is 
stable at room temperature (max. +30 °C) for 30 minutes.

CAUTION

Do not exceed the PCR mix storage time, as this could compromise 
product performance.
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7.6.6  Starting a PCR run
The PCR run is performed on a CFX96™ DW Dx under control of the CFX 
Manager™ Dx software.

1.	 Switch on the CFX96™ DW Dx, the attached computer and the monitor. 

2.	 Start the CFX Manager™ Dx software. 

3.	 In the menu bar of the CFX Manager™ Dx software select File → Open → 
LIMS File… to open the Open LIMS File dialog.

4.	 In the opening Open LIMS File dialog, make sure that the cursor is blinking in 
the File name field at the bottom. If it is not, click into the File name field.

5.	 Scan the PCR plate barcode with the handheld barcode scanner to automatically 
select and open the correct LIMS file. The Run Setup dialog is displayed.

NOTE

All parameters required for the start of the PCR run are transferred 
automatically from the AltoStar® Connect software to the CFX96™ DW 
Dx by means of the cycler file.

6.	 Click the Open Lid button in the Run Setup dialog to open the lid of the 
CFX96™ DW Dx.

7.	 Briefly centrifuge the sealed PCR plate to ensure all liquid is at the bottom of 
the wells. 

8.	 Insert the sealed PCR plate into the heating block of the CFX96™ DW Dx with 
well A1 to the left side. 

9.	 Close the CFX96™ DW Dx by clicking the Close Lid button in the Run Setup 
dialog. 

10.	Start the PCR run by clicking the Start Run button in the Run Setup dialog.
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7.6.6.1  During the PCR run
No user interaction is required until the PCR run has finished. The Run Details dialog 
is displayed showing the status of the PCR run and the estimated time remaining.

NOTE

Opening the lid of the CFX96™ DW Dx during a PCR run by operating 
the button at the front of the lid or by clicking Open Lid in the Run 
Details dialog will abort the run and void all results.

At the end of the PCR run the Data Analysis window is displayed, which shows the 
amplification curves, the plate layout and the results.

7.6.6.2  Assigning assays to well groups
The AltoStar® Workflow processes one or several PCR assays simultaneously on 
one PCR plate. However, each assay must be analyzed separately by the user 
according to the instructions for use of the respective assay.

To this end, all assays on a PCR plate must be assigned to individual well groups in 
the CFX Manager™ Dx software by the user.
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1.	 In the Data Analysis window click the Plate Setup button in the tool bar and 
select View/Edit Plate. The Plate Editor dialog is displayed (see figure 1).

Figure   1: Plate Editor dialog

2.	 In the Plate Editor dialog click Well Groups… in the tool bar. The Well Groups 
Manager dialog is displayed (see figure 2).

3.	 Click the Add button. 

4.	 Type the name of the first assay in the text box.
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5.	 Select all wells in the PCR plate area that belong to the first assay (see figure 2). 
The wells belonging to an individual assay can be identified in the Plate Editor 
dialog by the entry in the Biological Set field.

Figure   2: Well Groups Manager dialog

6.	 Repeat steps 3–5 for all assays on the PCR plate. 

7.	 Confirm well group assignment by clicking OK. The Well Groups Manager 
dialog closes. 

8.	 Close the Plate Editor dialog by clicking OK. 

9.	 Confirm to apply the changes by clicking Yes.
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7.6.7  PCR data analysis
The results of all assays (well groups) on the PCR plate have to be analyzed in the 
sequence depicted in figure 3.

Figure   3: PCR Data Analysis process
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In the Data Analysis window ensure to select the Well Group of the AltoStar® HBV 
PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right next to the 
Well Group button (see figure 4) of the toolbar. Do not use the “All Wells” Well 
Group. The selection in figure 4 is used as a general example view.

Before analyzing the results, ensure that the well group of the AltoStar® HBV 
PCR Kit 1.5 contains all of the AltoStar® HBV PCR Kit 1.5 wells and no wells of 
other assays.

Figure   4: Well Group button and Well Group drop-down menu

NOTE

Combined analysis of more than one assay may lead to incorrect results.

CAUTION

As with any diagnostic test, results shall be interpreted in consideration 
of all clinical and laboratory findings.

7.6.7.1  Baseline correction
The baseline settings used by the CFX Manager™ Dx software may have to be 
corrected for individual wells of the assay (Well Group) under analysis.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar.

2.	 At the left side of the Data Analysis window tick only the FAM checkbox for the 
HBV target detection channel. 
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3.	 In the menu bar of the Data Analysis window click Settings → Baseline 
Threshold… to open the Baseline Threshold dialog (see figure 5). 

4.	 Click the ◊ symbol in the Baseline End column header once to sort the table 
by ascending Baseline End values. 

5.	 Select all lines that show a Baseline End value of 1–9 (see figure 5).

Figure   5: Baseline Threshold dialog

6.	 Set the value in the End: field to 45 for the selected lines (see figure 5). 

7.	 Confirm the settings by clicking OK. 

8.	 At the left side of the Data Analysis window untick the FAM checkbox and tick 
only the VIC checkbox for the IC target detection channel. 

9.	 Repeat steps 3–7 for the VIC™ (IC) detection channel.
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7.6.7.2  Exclusion of irregular PCR signals
Valid results can only be derived from PCR signals that are free of signal artefacts, 
which may be caused e.g. by impurities or bubbles in the PCR mix. PCR signals that 
contain signal artefacts have to be excluded by the user.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar. 
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2.	 Identify wells with irregular PCR signals (linear signal increase, signal spikes, 
etc.) in any of the FAM™ (HBV target) and the VIC™ (IC) detection channels 
(see figure 6).

Figure   6: Data Analysis window: irregular PCR signal
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3.	 Click each affected well with the right mouse button and select Well... → 
Exclude from Analysis (see figure 7).

Figure   7: Data Analysis window: exclude well from analysis
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4.	 The selected well is excluded from the analysis. No results will be generated 
for this well (see figure 8).

Figure   8: Data Analysis window: excluded well
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7.6.7.3  Setting of thresholds
The thresholds for the FAM™ (HBV target) and the VIC™ (IC) detection channels 
have to be set manually by the user according to the signals of the controls.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar. 
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2.	 At the left side of the Data Analysis window tick only the VIC checkbox for the 
detection channel of the IC (see figure 9).

Figure   9: Data Analysis window: setting the VIC™ threshold
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3.	 Select only the NTC well in the plate view of the Data Analysis window (see 
figure 9). 

4.	 Drag the threshold into the exponential area of the NTC signal (see figure 9).

NOTE

The NTC contains the IC template, which leads to an IC signal in a valid 
NTC well.

5.	 At the left side of the Data Analysis window untick the VIC checkbox and tick 
the FAM checkbox for the detection channel of the HBV target (see figure 10).
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Figure   10: Data Analysis window: setting the FAM™ threshold

6.	 Select only the wells containing the NTC and the QSs in the plate view of the 
Data Analysis window (see figure 10). 

7.	 Drag the threshold well above the signal of the NTC into the exponential area 
of the QSs signals (see figure 10).
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7.6.8  Validity of PCR results

7.6.8.1  Exclusion of wells containing invalid data
Wells that do not contain valid data have to be excluded from result generation by 
the user.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar.

2.	 Identify all wells containing invalid data. A well is invalid if any of the following 
conditions apply:

a)	 The complete run is invalid (see chapter 7.6.8.2 Validity of a diagnostic 
PCR run).

b)	 The well data does not meet the control conditions for a valid result (see 
chapter 7.6.8.3 Validity of results for a sample).
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3.	 Click each well containing invalid data according to chapters 7.6.8.2 Validity of 
a diagnostic PCR run to 7.6.8.3 Validity of results for a sample with the right 
mouse button and select Well... → Exclude from Analysis (see figures 11 
and 12).

Figure   11: Data Analysis window: invalid well
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Figure   12: Data Analysis window: exclude invalid well from analysis

The selected well is excluded from the analysis. No results will be generated for 
this well.
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7.6.8.2  Validity of a diagnostic PCR run
A diagnostic PCR run is valid, if:

a) the following control conditions are met:

Table   8: Control conditions for a valid PCR run

Control Detection channel

FAM™  
(HBV target)

VIC™ 
(IC)

QS + Not applicable

NTC - +

and b) the generated standard curve reaches the following control parameter value:

Table   9: Standard curve control parameter

Control parameter Valid value

R square (R2) ≥ 0.98
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The standard curve's control parameter is displayed below the Standard curve 
graph in the Data Analysis window (see figure 13).

Figure   13: Standard curve data

A diagnostic PCR run is invalid, if:

•	 The run has not been completed.

•	 Any of the control conditions for a valid diagnostic PCR run are not met.

In case of an invalid diagnostic PCR run, exclude all wells from the analysis and 
repeat the AltoStar® run starting from the original samples.

7.6.8.3  Validity of results for a sample
The result for an individual sample is invalid, if the signals in both the VIC™ (IC) 
detection channel and the FAM™ (HBV target) detection channel are negative (see 
table 10). In case of an invalid result for a sample, exclude the well from the analysis 
and repeat testing from the original sample or collect and test a new sample.
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Table   10: Result validity

Detection channel

Result validityFAM™ 
(HBV target)

VIC™ 
(IC)

+ + Valid result

+ - Valid result* 

- + Valid result

- - Invalid result

*	 Detection of the IC is not required when the HBV target is detected. A high HBV DNA load in 
the sample can lead to a reduced or absent IC signal.

7.6.9  Export of PCR results for automated result interpretation
To make the PCR run results available to a connected LIMS for automated result 
interpretation they need to be exported in the form of a LIMS result file (.csv).

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar.

2.	 Ensure that all steps of the analysis process (see chapters 7.6.7.1 Baseline 
correction to 7.6.8.1 Exclusion of wells containing invalid data) have been 
completed for the well group of the AltoStar® HBV PCR Kit 1.5.

3.	 In the menu bar of the Data Analysis window click Export → Export All Data 
Sheets to open the Browse For Folder dialog.

4.	 In the Browse For Folder dialog specify the location for the LIMS result files to 
be generated and click OK.

NOTE

The LIMS integration has to be implemented according to the 
specifications of altona Diagnostics. For information regarding LIMS 
integration, see chapter 15. Assay protocol for the AltoStar® Connect 
software and information for LIMS integration and/or contact altona 
Diagnostics technical support (see chapter 11. Technical support).
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NOTE

Saving results of more than one assay (well group) from a PCR run in 
the same folder leads to replacement of the LIMS result files of the first 
assay (well group) with the LIMS result files of the second assay (well 
group). In this case the LIMS result files of the first assay (well group) 
can be exported again.

7.6.10  Export of PCR results for manual result interpretation
If the results are not passed to a LIMS for automatic result interpretation, the result 
interpretation has to be performed manually by the user. To this end the analysis 
results of each assay (well group) need to be exported in the form of a report.

1.	 In the Data Analysis window ensure to select the Well Group of the AltoStar® 
HBV PCR Kit 1.5. Therefore, click on the Well Group drop-down menu right 
next to the Well Group button (see figure 4) of the toolbar. 

2.	 At the left side of the Data Analysis window tick the VIC checkbox as well as 
the FAM checkbox.

3.	 Ensure that all steps of the analysis process (see chapters 7.6.7.1 Baseline 
correction to 7.6.8.1 Exclusion of wells containing invalid data) have been 
completed for the well group of the AltoStar® HBV PCR Kit 1.5.

4.	 In the menu bar of the Data Analysis window click Tools → Reports... to open 
the Report dialog.
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5.	 Ensure that at least the following content is selected for report generation in the 
upper left part of the Report dialog (see figure 14):

Figure   14: Report dialog

6.	 Select or deselect additional content of the report by ticking the respective 
check boxes as required. 

7.	 In the menu bar of the Report dialog click File → Save As... to open the Save 
Report dialog.

8.	 In the Save Report dialog specify the name and location for the report file to be 
generated and click Save.
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7.6.10.1  Manual interpretation of results
1.	 Open the report file generated for the well group of the AltoStar® HBV PCR Kit 1.5 

(see chapter 7.6.10 Export of PCR results for manual result interpretation). 

2.	 Refer to the Quantification Data table in the report (see figure 15). The table 
comprises 2 rows for each Sample – one for the Target HBV and one for the 
Target Internal Control.

Figure   15: Report: Quantification Data

Results are marked by a Concentration factor in the Well Note column of the 
Quantification Data table (see figure 15).

3.	 Refer to the Starting Quantity (SQ) column for the concentration of the HBV 
target measured in the eluate of the respective Sample. To calculate the result 
for the original patient sample, the Starting Quantity (SQ) value has to be 
multiplied by the respective Concentration factor (including the unit) by the 
user.

4.	 Refer to table 11 for interpretation of results.
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Table   11: Result interpretation

Starting Quantity (SQ) of the HBV target Result interpretation

> 0

HBV specific DNA detected. Multiply the 
Starting Quantity (SQ) value by the 
Concentration factor in the Well Note 
column (including the unit) to calculate the 
concentration of the original patient sample.

N/A
No HBV specific DNA detected. Sample 
does not contain detectable amounts of HBV 
specific DNA.

8.  Performance data
The performance of the AltoStar® HBV PCR Kit 1.5 was evaluated using the 4th WHO 
International Standard for HBV DNA for Nucleic Acid Amplification Techniques 
(NIBSC code: 10/266, genotype A2) and HBV standard material calibrated against 
the WHO International Standard.

8.1  Plasma

8.1.1  Analytical sensitivity
For the determination of the limit of detection (LoD) a dilution series of the 4th WHO 
International Standard for HBV DNA for Nucleic Acid Amplification Techniques 
(NIBSC code: 10/266, genotype A2) in EDTA plasma ranging from 1.00E+02 to 
5.00E-01 IU/ml was generated.

Each dilution was tested in 8 replicates in 3 different runs (total n = 24 per dilution) 
using combinations of:

•	 3 AltoStar® HBV PCR Kit 1.5 lots

•	 3 AltoStar® Purification Kit 1.5 lots

•	 3 AltoStar® Internal Control 1.5 lots

•	 3 AltoStar® AM16 instruments

•	 3 CFX96™ DW Dx instruments
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Data from all runs were combined and a probit analysis was performed to determine 
the 95 % LoD value.

Table   12: PCR results used for the calculation of the analytical sensitivity of the AltoStar® 
HBV PCR Kit 1.5

Concentration 
[IU/ml]

N [total] N [positive] Hit rate [%]

1.00E+02 24 24 100

5.00E+01 24 24 100

2.00E+01 24 24 100

1.00E+01 24 23 96

7.00E+00 24 21 88

5.00E+00 24 20 83

2.50E+00 24 9 38

1.00E+00 24 1 4

5.00E-01 24 2 8

The LoD of the AltoStar® HBV PCR Kit 1.5 for the detection of HBV in EDTA plasma 
is 10.2 IU/ml (95 % confidence interval: 7.6–15.8 IU/ml).

The LoD for the HBV genotypes B–H was confirmed according to the protocol 
described in CLSI guideline EP17-A2 (“Evaluation of Detection Capability for Clinical 
Laboratory Measurement Procedures; Approved Guideline-Second Edition”).

For each genotype HBV negative EDTA plasma was spiked with HBV to a final 
concentration of the LoD value (10.2 IU/ml) determined for the 4th WHO International 
Standard for HBV DNA for Nucleic Acid Amplification (NIBSC code: 10/266, 
genotype A2). Subsequently, the samples were tested in 3 different runs using 
combinations of 3 AltoStar® HBV PCR Kit 1.5 lots, 3 AltoStar® Purification Kit 1.5 
lots and 3 AltoStar® Internal Control 1.5 lots (n = 20 per run; 60 replicates in total).
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Table   13: Confirmation of the analytical sensitivity for HBV genotypes B–H

HBV genotype N [total] N [positive] Hit rate [%]

 B 60 56 93

 C 60 57 95

 D 60 56 93

 E 60 59 98

 F 60 56 93

 G 60 60 100

 H 60 59 98

The results confirmed a LoD of at least 10.2 IU/ml for HBV genotypes B–H.

8.1.2  Analytical specificity
The analytical specificity of the AltoStar® HBV PCR Kit 1.5 is ensured by the thorough 
selection of the oligonucleotides (primers and probes). The oligonucleotides were 
checked by sequence comparison analysis against publicly available sequences to 
ensure that all relevant HBV genotypes will be detected.

For the verification of the analytical specificity of the AltoStar® HBV PCR Kit 1.5 the 
following experiments were performed (see chapters 8.1.2.1 Negative samples to 
8.1.2.3 Cross-reactivity).

8.1.2.1  Negative samples
104 HBV negative EDTA plasma samples from individual donors were tested with 
the AltoStar® HBV PCR Kit 1.5. All (104 out of 104) samples were tested negative for 
HBV specific DNA and positive for the IC. The analytical specificity of the AltoStar® 
HBV PCR Kit 1.5 for EDTA plasma samples is ≥ 99 %.
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8.1.2.2  Interfering substances
To evaluate the influence of potentially interfering endogenous and exogenous 
substances on the performance of the AltoStar® HBV PCR Kit 1.5 selected 
substances were spiked in EDTA plasma samples. These plasma samples 
contained HBV in a concentration of the 3 x LoD (3.06E+01 IU/ml), 1.50E+03 IU/ml 
and no HBV, respectively.

Results obtained for samples containing potentially interfering substances were 
compared to results generated for EDTA plasma samples containing no spiked 
interferent. Each sample was processed in 3 replicates.

No interference was observed for samples containing elevated levels of:

•	 Endogenous substances

	◦ Bilirubin

	◦ Hemoglobin

	◦ Human genomic DNA

	◦ Human serum albumin

	◦ Triglycerides

•	 Exogenous substances

	◦ Adefovir

	◦ Entecavir

	◦ Interferon-α 2a

	◦ Lamivudine

	◦ Telbivudine

	◦ Tenofovir

Additionally, EDTA plasma samples from patients suffering from autoimmune 
diseases (systemic lupus erythematosus and rheumatoid arthritis) were tested 
with the AltoStar® HBV PCR Kit 1.5 with and without spiking with HBV to a final 
concentration of 3.06E+01 IU/ml and 1.50E+03 IU/ml, respectively. No interference 
in terms of specificity, sensitivity and reliable quantification was observed.
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CAUTION

The presence of PCR inhibitors (e.g. heparin) could cause false negative 
or invalid results.

8.1.2.3  Cross-reactivity
The analytical specificity of the AltoStar® HBV PCR Kit 1.5 with respect to cross-
reactivity with other pathogens than HBV was evaluated by testing:

•	 Viruses related to HBV

•	 Viruses causing similar symptoms as an infection with HBV

•	 Viruses likely to be present in patients suffering from a HBV infection

The AltoStar® HBV PCR Kit 1.5 did not cross-react with any of the following 
pathogens:

•	 Cytomegalovirus (CMV)

•	 Epstein-Barr virus (EBV)

•	 Hepatitis A virus (HAV)

•	 Hepatitis C virus (HCV)

•	 Hepatitis D virus (HDV)

•	 Hepatitis E virus (HEV)

•	 Herpes simplex virus 1 (HSV-1)

•	 Herpes simplex virus 2 (HSV-2)

•	 Human immunodeficiency virus 1 
(HIV-1)

•	 Human T-lymphotropic virus I 
(HTLV-I)

•	 Human T-lymphotropic virus II 
(HTLV-II)

•	 Parvovirus B19

CAUTION

In case the sample contains other pathogens than HBV, competition 
with the target amplification or cross-reactivities may occur, causing 
incorrect IVD examination results.
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8.1.3  Linear range
For the determination of the linear range of the AltoStar® HBV PCR Kit 1.5 a dilution 
series of HBV in negative EDTA plasma ranging from 1.00E+07 to 2.00E+01 IU/ml 
was tested:

•	 Dilutions with a concentration between 1.00E+07 and 1.00E+05 IU/ml were 
tested in 4 replicates.

•	 Dilutions with a concentration between 1.00E+04 and 2.00E+01 IU/ml were 
tested in 8 replicates.

Analysis was performed based on a polynomial regression.

The linear range of the AltoStar® HBV PCR Kit 1.5 for the quantification of HBV in 
EDTA plasma is 2.00E+01–1.00E+07 IU/ml. A graphical representation of the data 
is shown in figure 16.

log10 estimated concentration vs. log10 nominal concentration 
AltoStar® HBV PCR Kit 1.5
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Figure   16: Linear regression analysis of the AltoStar® HBV PCR Kit 1.5 with EDTA 
plasma samples
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8.1.4  Precision
Precision of the AltoStar® HBV PCR Kit 1.5 was evaluated using a panel consisting 
of:

•	 1 HBV high positive (1.50E+03 IU/ml) EDTA plasma sample

•	 1 HBV low positive [1.00E+02 IU/ml (5 x lower limit of quantitation (LLoQ))] 
EDTA plasma sample

•	 1 HBV negative EDTA plasma sample

Each panel member was tested in at least 4 replicates per run.

5 runs were performed on 5 different days using combinations of:

•	 3 AltoStar® HBV PCR Kit 1.5 lots

•	 3 AltoStar® Purification Kit 1.5 lots

•	 3 AltoStar® Internal Control 1.5 lots

•	 3 AltoStar® AM16 instruments

•	 3 CFX96™ DW Dx instruments

Repeatability (intra-run variability), inter-lot variability and reproducibility (total 
variability) were determined based on:

•	 Quantification values for the HBV high and low positive samples (see table 14)

•	 Threshold cycle (Cq) values for the IC in the HBV negative samples (see 
table 15)

Table   14: Precision data (CV % log10 quantification data) for HBV high and low positive 
EDTA plasma samples

HBV high positive sample 
(1.50E+03 IU/ml)

HBV low positive sample 
(1.00E+02 IU/ml)

Intra-run variability 0.67–3.41 3.15–8.33

Inter-lot variability 2.94 6.87

Total variability 2.83 6.68
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Table   15: Precision data (CV % Cq values) for the IC in HBV negative EDTA plasma 
samples

IC

Intra-run variability 1.18–2.00

Inter-lot variability 2.99

Total variability 6.20

In addition, site-to-site variability was assessed by testing a sample panel at  
3 different laboratories. The sample panel comprised HBV positive EDTA plasma 
samples at 3 different concentrations [1.50E+03 IU/ml, 1.00E+02 IU/ml (5 x LLoQ) 
and 3.06E+01 IU/ml (3 x LoD)] as well as HBV negative samples. The results 
obtained for the 1.50E+03 IU/ml and 1.00E+02 IU/ml sample are summarized in 
table 16.

Table   16: Precision data (CV % log10 quantification data) site-to-site variability

HBV high positive sample 
(1.50E+03 IU/ml)

HBV low positive sample 
(1.00E+02 IU/ml)

Site-to-site variability 5.01 10.88

8.1.5  Total failure rate
The robustness of the AltoStar® HBV PCR Kit 1.5 was assessed by testing 104 HBV 
negative EDTA plasma samples from individual donors spiked with HBV to a final 
concentration of the 3 x LoD (3.06E+01 IU/ml). 99 % (103 out of 104) of the samples 
were tested positive in the HBV specific fluorescence detection channel (FAM™).
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8.1.6  Carry over
Carry over is mostly a workflow dependent risk and independent of the PCR assay 
used. For the AltoStar® Workflow the AltoStar® Parvovirus B19 PCR Kit 1.5 was 
used as exemplary model. Potential cross-contamination through carry over from 
high positive samples was evaluated by testing alternating parvovirus B19 high 
positive (1.00E+07 IU/ml) and negative samples (n = 23 each per run; 5 runs) with 
the AltoStar® Parvovirus B19 PCR Kit 1.5. No carry over was observed, i.e. all 
parvovirus B19 negative samples were tested negative.

8.1.7  Clinical performance
The AltoStar® HBV PCR Kit 1.5 was evaluated in a comparative study with the CE-
marked Abbott RealTime HBV Assay (Abbott Molecular). Retrospectively, 316 EDTA 
plasma specimens from routine HBV monitoring were tested in parallel with the 
Abbott RealTime HBV Assay (Abbott Molecular) and the AltoStar® HBV PCR Kit 1.5.

The Abbott RealTime HBV Assay (Abbott Molecular) was used in combination with 
the Abbott mSample Preparation System (Abbott Molecular) and the Abbott m2000 
Complete System (Abbott Molecular).

The AltoStar® HBV PCR Kit 1.5 was used in combination with the AltoStar® 
Purification Kit 1.5 and the AltoStar® Internal Control 1.5 on the AltoStar® AM16 and 
the CFX96™ DW Dx.
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For the analysis of diagnostic sensitivity and specificity 272  valid samples were 
used. Results are shown in table 17.

Table   17: Results of the evaluation of the diagnostic sensitivity and specificity for HBV in 
EDTA plasma samples 

Abbott RealTime HBV Assay (Abbott Molecular)
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The diagnostic sensitivity and specificity of the AltoStar® HBV PCR Kit 1.5 compared 
to the Abbott RealTime HBV Assay (Abbott Molecular) were 100 % (confidence 
interval 97.3 %–100.0 %) and 95 % (confidence interval 90.0 %–97.9 %), respectively.
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For the quantitative correlation samples tested negative with one or both assays 
were excluded. After outlier removal the results of the remaining 132 samples were 
used for the quantitative correlation by linear regression analysis (see figure 17).

Abbott RealTime HBV Assay (Abbott Molecular) vs. 
AltoStar® HBV PCR Kit 1.5
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Figure   17: Linear regression analysis of the results obtained with the Abbott RealTime 
HBV Assay (Abbott Molecular) (reference) and the AltoStar® HBV PCR Kit 1.5

There was very good correlation between the quantitative results obtained with the 
AltoStar® HBV PCR Kit 1.5 and the Abbott RealTime HBV Assay (Abbott Molecular) 
[correlation coefficient R = 0.96 (R2 = 0.93)].
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9.  Disposal
Dispose of hazardous and biological waste in compliance with local and national 
regulations. Leftover product components and waste should not be allowed to enter 
sewage, water courses or the soil.

CAUTION

Always treat samples as infectious and (bio-)hazardous material in 
accordance with safety and laboratory procedures. For sample material 
spills promptly use an appropriate disinfectant. Handle contaminated 
materials as biohazardous.

CAUTION

Disposal of hazardous and biological waste shall comply with local and 
national regulations to avoid environmental contamination.

NOTE

The PCR plate must be disposed of in a sealed state since the PCR 
Plate Sealing Foil cannot be removed.

10.  Quality control
In accordance with the altona Diagnostics GmbH EN ISO 13485-certified Quality 
Management System, each lot of AltoStar® HBV PCR Kit 1.5 is tested against 
predetermined specifications to ensure consistent product quality.
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11.  Technical support
For customer support, contact altona Diagnostics technical support:

e-mail: 	 support@altona-diagnostics.com

phone: 	 +49-(0)40-5480676-0

NOTE

Any serious incident that has occurred in relation to this product shall 
be reported to altona Diagnostics and the competent authority of your 
country.

12.  Literature
[1]	 https://talk.ictvonline.org/ictv-reports/ictv_9th_report/reverse-transcribing-dna-and-

rnaviruses- 2011/w/rt_viruses/155/hepadnaviridae

[2]	 https://academic.oup.com/labmed/article/42/8/488/2657686

[3]	 https://www.who.int/news-room/fact-sheets/detail/hepatitis-b

13.  Trademarks and disclaimers
4s3™ (4titude); AltoStar® (altona Diagnostics); CFX96™, CFX Manager™ (Bio-
Rad); LOINC® (Regenstrief Institute, Inc.); FAM™, VIC™ (Thermo Fisher Scientific).

Registered names, trademarks, etc. used in this document, even if not specifically 
marked as such, are not to be considered unprotected by law.

The AltoStar® HBV PCR Kit 1.5 is a CE-marked diagnostic kit according to the 
European in vitro diagnostic directive 98/79/EC.

Product not licensed with Health Canada and not FDA cleared or approved.

Not available in all countries.

© 2021 altona Diagnostics GmbH; all rights reserved.
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14.  Symbols
Symbol Explanation

V
In vitro diagnostic medical device

*
Global Trade Item Number

g
Batch code

.
Content

/
Cap color

h
Catalogue number

#
Number

,
Component

i
Consult instructions for use

X
Contains sufficient for "n" tests/reactions 
(rxns)

l
Temperature limit

H
Use-by date

M
Manufacturer

Y
Caution

&
Material number

A
Version

=
Note
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Symbol Explanation

)
Contains biological material of animal origin
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15.  Assay protocol for the AltoStar® Connect software and 
information for LIMS integration

The 2D barcode in figure 18 is to be used for installing the latest assay protocol 
for use of the AltoStar® HBV PCR Kit 1.5 on the AltoStar® AM16. The barcode can 
only be scanned in printed form. You can scan the barcode directly from the manual 
or print it on a separate sheet. Please note that the size of the print affects the 
scannability of the barcode. Make sure to scale the size to 100 %. For scanning, 
aim the scanner to the red line on the barcode. For details on management of assay 
protocols, please refer to the respective chapter in the instructions for use of the 
AltoStar® Connect software. For information for LIMS integration, see table 19.

AltoStar® HBV PCR Kit 1.5

Checksum: 6C315B6A7547CFEEE462EA45998929B31B4164CE
11PPrroottooccooll VVeerrssiioonn::

Figure   18: Assay protocol barcode for the AltoStar® HBV PCR Kit 1.5

Table   18: Changelog for the assay protocol

Protocol version Release updates

1 Initial version



76

AltoStar® HBV PCR Kit 1.5

Table   19: Information for LIMS integration

Usage Data

Test order (LIMS → AltoStar® AM16) AltoStar® HBV PCR Kit 1.5

Test result (CFX96™ DW Dx → LIMS) unit IU/ml

Test result (CFX96™ DW Dx → LIMS) 
channel 1

HBV

Test result (CFX96™ DW Dx → LIMS) 
channel 2

Internal Control

For LOINC® (Logical Observation Identifiers Names and Codes) please refer to the 
altona Diagnostics GmbH website (www.altona-diagnostics.com) or contact altona 
Diagnostics technical support (see chapter 11. Technical support).
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16.  Revision history
Table   20: Revision history

Identifier
Date of issue  
[month/year]

Modifications

MAN-AS0201510-
EN-S05

10/2021

•	 adaption of a new structure for the whole 
instructions for use

•	 adaption of the intended use in chapter 2
•	 adaption of table 3 “Required material and 

devices” in chapter 7.4
•	 adaption of the description of the sealing 

process using the new PCR plate sealing 
foil with the imprint “THIS SIDE UP” and an 
additional plate sealer in chapter 7.6.5

•	 addition of the symbol “contains biological 
material of animal origin” in chapter 14

•	 introduction of an assay protocol barcode in the 
new chapter 15
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